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ImageJ macro

• Day 1: Scripting in ImageJ / Fiji allows reproducible workflows.

• Day 2: Run workflows on hundreds over folders of images!

Image data source: Anne Esslinger, Alberti lab, MPI CBG
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Online documentation

• Important ImageJ macro websites

https://imagej.nih.gov/ij/developer/macro/functions.htmlhttps://imagej.nih.gov/ij/developer/macro/macros.html
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ImageJ, Fiji & friends: community

• Visit http://forum.image.sc !
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Cheat sheets!

• https://github.com/BiAPoL/imagej-macro-cheat-sheet/blob/master/ImageJ_macro_cheatsheet.pdf

Thanks to 
Benoit Lombardot, 

Gayathri Nadar, 
Jens Ehrig and 

Noreen Walker for 
contributing to and 

maintaining this document!
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Example code for this course

• https://github.com/BiAPoL/CCI_Gothenburg_ImageJ_Macro_Course_2021
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How to eat a banana

• Remove shell

• Repeat until nothing left:

• Take a bite

• Chew

• Swallow

• Digest

• Access folder

• Repeat  for all images:

• Open an image file

• Segment the banana slice

• Analyse it

• Save measurements

using ImageJ macrothe computational way

Image data source: Nasreddin Abolmaali, Robert Haase, TU Dresden
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ImageJ macro programming: 
Variables and operations

Robert Haase

With material from 

Benoit Lombardot, Scientific Computing Facility, MPI CBG
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Variables

• Variables hold values and can be connected using operators

// initialise program

a = 1;

b = 2.5;

// run complicated algorithm

final_result = a + b;

// print the result

print( final_result );

variables.ijm
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Mathematical operations

• Math commands supplement operators to be able to implement any form of calculations

Command Description Example

sin(x) sinus of x given in radians b = sin(PI);

cos(x) cosinus of x given in radians b = cos(PI);

tan(x) tangens of x given in radians b = tan(PI);

Command Description Example

pow(x, y) x to the power of y a = pow(3, 2);

sqrt(x) square root of x a = sqrt(81);

abs(x) absolute value of x a = abs(-9);

round(x) rounding of x a = round(9.4);
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// Comments

Comments should contain additional information such as

//

// This program sums up two numbers.

//

// Usage:

// * Run it in FIJI (www.fiji.sc)

//

// Author: Robert Haase, MPI CBG,

//         rhaase@mpi-cbg.de

// July 2016

// initialise program

a = 1;

b = 2.5;

// run complicated algorithm

final_result = a + b;

// print the final result

print( final_result );

• User documentation 

• What does the program do?

• How can this program be used?

• Your name / institute in case a 
reader has a question

• Comment why things are done.

• Do not comment what is written in 
the code already!

good_comments.ijm
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Learning by doing!
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/* Comments and markdown */

• Write your own ImageJ
macro notebooks!

• Use:

/*

# Headlines

* Bullet points

[Links](http://fiji.sc)

*/

Installation

• https://github.com/haesleinhuepf/imagejmacromarkdown
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ImageJ Macro Markdown installation

• Available via the IJMMD update site

14

2

3

1
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Learning by doing
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Strings

• Texts are called “strings” in the world of programming

• They represent a chain of characters

// initialise program

firstname = "Robert";

lastname = "Haase";

// run complicated algorithm

name = firstname + " " + lastname;

print("Hello " + name + "!");

string_variables.ijm
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Code highlights

• Colours help us to read and understand what we see:

• comments / documentation 

• commands / action

• values (numbers, vectors, texts)

• If something is wrong with the colour, likely something is wrong with the program.

code_highlights.ijm
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Learning by doing!
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Learning by doing!
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Learning by doing!



@haesleinhuepf 21Virtually at CCI Gothenburg, October 2021

Learning by doing!



@haesleinhuepf 22

ImageJ macro programming: 
Recording macros & working with images

Robert Haase

With material from 

Benoit Lombardot, Scientific Computing Facility, MPI CBG 

Virtually at CCI Gothenburg, October 2021
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Macro Recording
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Macro recording

• Editing recorded macros needs to be trained. It’s 80% reading and 20% writing 

• Hints:
• Put comments first. Try to understand what was recorded and why.
• Do it in tiny steps. As soon as you have a working workflow consisting of 4-5 steps, create a macro.
• Collect macros. When you do something new, do cherry picking from the old macros.
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The run() command

• The first parameter of the run command is the menu you want to call

• The following parameter contains the entries of the dialog in case the menu has one.

• Numeric values: “label=value”

• Checkboxes: “label” in case it is activated.

Calling any ImageJ/FIJI menus

run("Enhance Contrast...", "saturated=0.3 normalize")
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Working with image files

• Open and close commands allow handling image files.

// initialise program

imageFilename = ”/Users/rhaase/images/blobs.gif";

open( imageFilename );

// process the image

// ...

close();

Built-in command Description Parameters

open(filename); open an image filename of the image

close(); close current image
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Working with image files

• Firstly, lets read image properties

// initialise program

imageFilename = "blobs.gif";

open( imageFilename );

// read image properties

width = getWidth();

height = getHeight();

getPixelSize(unit, pixelWidth, pixelHeight);

// show results

print("The image is " + width + " times " + height + " pixels wide");

print("Each pixels has a size of " + pixelWidth +

" times " + pixelHeight + " " + unit + ”^2");

close();

Built-in command Description Parameters

width = getWidth();
height = getHeight();

return the width/height of the current 
image

getPixelSize(unit, pWidth, pHeight) get size of a pixel variables where physical unit, width 
and height will be stored

getVoxelSize(vWidth, vHeight, vDepth, 
unit)

get size of a voxel variables where width, height, depth 
and physical unit will be stored

read_image_properties.ijm
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Working with image files

• Let’s do some pixel value statistics

// initialise program

imageFilename = "blobs.gif";

open( imageFilename );

// get image statistics

getStatistics(area, mean, min, max, std);

// show results

print("The grey value ranges from " + min + " to " + max + ". ");

print("It has an average of " + mean + " +- " + std + ". ");

close();

Built-in command Description Parameters

getStatistics(area, mean, min, max, std) get statistics of an image or a region in 
the image

area in physical units, 
mean average grey value, 
minimum grey value, 
maximum grey value,
standard deviation of grey value

image_statistics.ijm
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Switching between windows

• If you work with several images, you may want to switch between them. Use 

• getTitle() to get the headline of the current window

• selectWindow(title) to select a window to bring it to the front

• rename(new_title) to change the name of a window
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Switching between windows

• Before “destroying” an image, make a duplicate!
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Learning by doing
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Deep-learning based segmentation: StarDist

• Better segmentation using modern computational methods (deep learning)

Slide adapted / courtesy of Martin Weigert, EPFL @martweig

and additional constraints
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Deep-learning based segmentation: StarDist

• Deep-learning based image segmentation

Must be set as 
during training 

phaseAllows fine-
tuning ROI 
selection

Choose a model 
that fits your data!

https://imagej.net/StarDisthttps://www.youtube.com/watch?v=Amn_eHRGX5M
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Demo: StarDist segmentation
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Exercise: StarDist Installation

• Activate the “CSBDeep” and “StarDist” update sites.
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Break: 15 min

September 2021
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Image data flow graphs
Robert Haase

With materials from 

Elisabeth Kugler, The University of Sheffield, 

Daniela Vorkel, MPI CBG / CSBD

September 2021
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Image processing in life-sciences

• State-of-the-art software for more than 20 years: ImageJ / Fiji

56

2x

https://imagej.nih.gov/ij/  https://fiji.sc 
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How image processing is supposed to be

• (… in my honest opinion)

57

2x

https://clij.github.io/
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GPU acceleration + code generation

• After setting up the workflow, generate code!

58

Image data source: Elisabeth Kugler; labs of Tim Chico and Paul Armitage, The University of Sheffield 
(UK)" https://zenodo.org/record/4204839#.X8DCRGj7Q2w

Special 
thanks to 
Elisabeth 
Kugler!

Elisabeth Kugle
@KuglerElisabeth
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Image Data Flow Graph design

• The menu order is intentional: From preprocessing to analysis

59https://clij.github.io/
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Expert system: Suggestions

• Explore suggestions!

60https://clij.github.io/
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Fiji search bar

• In Fijis search bar result, there is a new category: CLIJx-assistant which offers IDFG operations

61



@haesleinhuepf 62Virtually at CCI Gothenburg, October 2021

Generate macros

• Generate scripts in multiple languages from a given Image Data Flow Graph

62
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CLIJ2: What every ImageJ Macro script must have

• Load data

• Initialize GPU

• Push

• Process images

• Pull

• Cleanup
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CLIJ2 macro editing

• Use the integrated online help!
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Demo: Segment blobs.gif

• Design a workflow for segmenting blobs.gif (File > Open Samples…)

• Export the workflow as ImageJ Macro script for and Fiji Jython.

65
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Demo: Segment blobs.gif

66
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Online documentation: tutorials

67

Dani Vorkel
(Myers lab)

@happifocus

Big thanks to 

https://clij.github.io/
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Online documentation: Cheat sheets

• Cheat sheets show the most important methods with input and output parameters visually.

68https://clij.github.io/clij2-docs/CLIJ2-cheatsheet_V3.pdf
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Last but not least: citability

• If you work with CLIJ and friends, please cite the paper(s). It’ll be hard to apply for grants otherwise.

69https://clij.github.io/
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Exercises

With material from 

Anne Esslinger, Albert Lab Biotec, MPI CBG

Benoit Lombardot, Scientific Computing Facility, MPI CBG 

October 2021
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Exercise: basic math with variables

• Calculate the distance of two points!

// initialise program

x1 = 3;

y1 = 5;

x2 = 7;

y2 = 8;

// run complicated algorithm

d =

print("The distance is " + d);

x1 x2

y1

y2

d

d = sqrt(pow(x1 - x2, 2) +

pow(y1 - y2, 2));

exercise_math.ijm

Optional Exercise: Write a 
function doing this! Hint:
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Optional exercise:  Type conversion

• Play with the macro language. Try things like the following and observe what’s happening.

// initialise program

a = "1";

b = 2;

// do some calculations

print(a + b);

print(b + a);

// initialise program

a = "1";

b = 2;

// do some calculations

print(a / b);

print(b / a);

// initialise program

a = "1";

b = 2;

// do some calculations

print(0 + a + b);

print("" + b + a);

// initialise program

a = "1";

b = 2;

// do some calculations

print(a / b);

print(b / a);
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Exercise: Segmentation

• Download and install Fiji
• http://fiji.sc/Downloads

• Download the BBBC001 dataset (TIF), unzip it and count nuclei in the first image file
• https://bbbc.broadinstitute.org/BBBC001
• AS_09125_050118150001_A03f00d0.tif

• Hints:
• Use automatic thresholding and 

the Watershed algorithm
• Summarize your measurement in the 

Particle Analyzer
• Select “Show: Count Masks”

• Use the “Glasbey on dark”
lookup table / color map

• Enter your count here: https://docs.google.com/spreadsheets/d/1Ek-
23Soro5XZ3y1kJHpvaTaa1f4n2C7G3WX0qddD-78/edit?usp=sharing

• Be a good scientist: Don’t cheat! ;-)

Record and curate 
a macro for this 

task! You will need 
it tomorrow ;-)
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Exercise: StarDist Installation

• Activate the “CSBDeep” and “StarDist” update sites.
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Exercise

• Download and install Fiji

• http://fiji.sc/Downloads

• Download the BBBC001 dataset (TIF), unzip it and count nuclei in the first image file

• https://bbbc.broadinstitute.org/BBBC001

• AS_09125_050118150001_A03f00d0.tif

• Hints:

• Use Plugins > StarDist > StarDist2D
to segment the nuclei

• Use Analyze > Set Measurements 
and Analyze > Measure to determine
the maximum intensity in the label 
image (= number of labels)

• Enter your count here: https://docs.google.com/spreadsheets/d/1Ek-
23Soro5XZ3y1kJHpvaTaa1f4n2C7G3WX0qddD-78/edit?usp=sharing

• Be a good scientist: Don’t cheat! ;-)
Image Data source: BBBC001v1 [Carpenter et al., Genome Biology, 2006] from 
the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

Record and curate 
a macro for this 

task! You will need 
it tomorrow ;-)
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Exercise CLIJ Installation

• Just activate the CLIJ and CLIJ2 update sites, in menu Help > Update…

• Do not install clijx! That’s experimental stuff you’re free to try out later.

• Linux users: you may need to install OpenCL, e.g.  apt-get install ocl-icd-devel

76
https://clij.github.io/clij2-docs/installationInFiji

2

3

1
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Exercise

• Download and install Fiji

• http://fiji.sc/Downloads

• Download the BBBC001 dataset (TIF), unzip it and count nuclei in the first image file

• https://bbbc.broadinstitute.org/BBBC001

• AS_09125_050118150001_A03f00d0.tif

• Hints:

• Use CLIJ Assistant [Right-click 
menu] Label > Voronoi-Otsu-
Labeling to segment the nuclei

• Use Analyze > Set Measurements 
and Analyze > Measure to determine
the maximum intensity in the label 
image (= number of labels)

• Enter your count here: https://docs.google.com/spreadsheets/d/1Ek-
23Soro5XZ3y1kJHpvaTaa1f4n2C7G3WX0qddD-78/edit?usp=sharing

• Be a good scientist: Don’t cheat! ;-)
Image Data source: BBBC001v1 [Carpenter et al., Genome Biology, 2006] from 
the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

Generate a macro 
for this task! You 

will need it 
tomorrow ;-)
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Hint: image.sc

• In case you run into trouble: Visit image.sc and ask. They may ask within 5 hours, even Saturdays.

The macro recorder records 
some line that doesn’t work.

https://forum.image.sc/t/imagej-saving-summary-table-not-working-as-expected/25172
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Summary

Today, you learned

• ImageJ macro

• Variables

• Working with files and images

• Macro recording

• Using the ROI manager

• Custom functions

• Exercises: 

• Macro recording and 

• image segmentation

Coming up next

• ImageJ macro

• Loops and conditions

• Interacting with tables

• Custom dialogs

• How to write readable code.
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Break: 21h
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ImageJ macro programming
Robert Haase

With material from 

Benoit Lombardot, Scientific Computing Facility, MPI CBG 

Virtually at CCI Gothenburg, October 2021
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Follow up: Macro recording

• Editing recorded macros needs to be trained. It’s 80% reading and 20% writing 

• Hints:
• Put comments first. Try to understand what was recorded and why.
• Do it in tiny steps. As soon as you have a working workflow consisting of 4-5 steps, create a macro.
• Collect macros. When you do something new, do cherry picking from the old macros.
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ImageJ macro programming: 
Conditions and loops

Robert Haase

With material from 

Benoit Lombardot, Scientific Computing Facility, MPI CBG 

Virtually at CCI Gothenburg, October 2021
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Conditions

• Image processing workflows rarely look like this
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Conditions

• Image processing workflows rather look like this

??

Yes

No

Yes

No

?

Yes

No

Conditional statement
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Conditions

• Depending on a condition, some lines of code are executed or not.

// do something

if ( condition ){
// do something if
// condition is true

}

// do a final thing
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Conditions

• Depending on a condition, some lines of code are executed or not.

// do something

if ( condition ){
// do something if
// condition is true

}

// do a final thing
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Conditions

• The else statement allows to program alternatives.

if ( condition ){

// do something if

// condition is true

}

else{

// do something else if

// condition is false

}

// do a final thing



@haesleinhuepf 89Virtually at CCI Gothenburg, October 2021

Conditions

• The if / else statement allows to program alternatives.

• Depending on a condition, either the one or the other block is executed.

• Curly brackets {} are used to mark where a block starts and ends.

• Indentation helps reading blocks.

if ( condition ){

// do something if

// condition is true

}

else{

// do something else if

// condition is false

}

// do in any case

Note: this line does not
end with a ; semicolon!
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Conditions

• Comparison operators always have true or false as results.

Operator Description Example

<, <= smaller than, smaller or equal to1 a < b

>, >= greater than, greater or equal to1 a > b

== equal to1 a == b

!= not equal to1 a != 1
1 these operators work also with string values

// initialise program

quality = 99.5;

// evaluate result

if (quality > 99.9) {

print(”Everything is fine.");

} else {

print(”We need to improve!");

}
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Combined conditions

• Logic operators always take conditions as operands and result in a condition.

• Conditions can be either true (1) or false (0).

Operator Description Example

&& and a < b && b < c

|| or a < b || b > c

! negation (“not”) !(a == b)

// initialise program

quality = 99.9;

age = 3;

if ((quality >= 99.9) && !(age > 5)) {

print("The item is ok.");

}
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Learning by doing!
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Why is indentation important?

• Does this program say “Yin” or “Yang”?

// initialise program

a=5;b=3;c=8;

// execute algorithm

d=(a+b)/c;

// evaluate result

if (b>0) {

if (a==5)

{

print("Yin");

}

else

{

if (c<5)

{

}

}

if (d!=0)

{

print("Yang");

}

}

// initialise program

a = 5;

b = 3;

c = 8;

// execute algorithm

d = (a + b) / c;

// evaluate result

if (b > 0) {

if (a == 5) {

print("Yin");

} else {

if (c < 5) {}

}

if (d != 0) {

print("Yang");

}

}

yin_yang.ijm

Yin

Yang

Yes, it’s the same 
program as on the 

left 
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Readable code

Rules for readable code

• Every command belongs on its own line

• Insert empty lines to separate important processing steps

• Put spaces between operators and operands, because:

This  is  easier  to  read thanthat,orisnt’it?

• Indent every conditional block (if/else) using the TAB key

• Hint: put the “{“ behind the if; it makes your program shorter.

• Make use of tools: http://jsbeautifier.org

if (a == 5)

{

print("Yin");

}

else

{

print("Yang");

}

// initialise program

a = 5;b = 3;c = 8;

// initialise program

a = 5;

b = 3;

c = 8;

// initialise program

a = 5;

b = 3;

c = 8;

// execute algorithm

d=(a+b)/c;

// evaluate result

// initialise program

a = 5;

b = 3;

c = 8;

// execute algorithm

d = (a + b) / c;

// evaluate result

if (a == 5)

{

print("Yin");

}

else

{

print("Yang");

}

if (a == 5) {

print("Yin");

} else {

print("Yang");

}
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Troubleshooting

If your program throws error messages:

• Don’t panic. 

• “There are two ways to write error-free programs; 
only the third one works.”

Alan J. Perlis, Yale University

• Read where the error happened. You may see your 
fault immediately, when looking at the right point.

• Read what appears to be wrong. If you know, what’s 
missing, you may see it, even if it’s missing in a 
slightly different place.

• Don’t take error messages to strict. It’s just a 
program reporting about an issue with another 
program. It may also have issues.
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Troubleshooting
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Troubleshooting
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Loops

• To repeat actions, you run code in loops

??

Yes

No

Yes

No

Loop statement

?
Yes

No
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Loops

• The for statement allows us to execute some lines of code for several times

// do something

for( <initializer>; <condition>; <iterator>) {

// do something repeatedly

}

// do something

Note: this line does not
end with a ; semicolon!



@haesleinhuepf 101Virtually at CCI Gothenburg, October 2021

Loops

• The for statement allows to execute some lines of code for several times

• The initializer is only executed once; at the beginning.

// do something

for( i = 0; i < 10; i++ ) {

// do something for 10 times

}

1. start: initialize counter i
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Loops

• The for statement allows to execute some lines of code for several times

• The initializer is only executed once; at the beginning.

• The condition is checked every time before the whole block is executed.

// do something

for( i = 0; i < 10; i++ ) {

// do something for 10 times

}

2. check condition
If true code is executed
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Loops

• The for statement allows to execute some lines of code for several times

• The initializer is only executed once; at the beginning.

• The condition is checked every time before the whole block is executed.

• After block execution, the counter is increased.

// do something

for( i = 0; i < 10; i++ ) {

// do something for 10 times

}

3. increase counter
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Loops

• The for statement allows to execute some lines of code for several times

• The initializer is only executed once; at the beginning.

• The condition is checked every time before the whole block is executed.

• After block execution, the counter is increased.

// do something once

for( i = 0; i < 10; i++ ) {

// do something for 10 times

}

2. check condition
If true: code is executed
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Loops

• The for statement allows to execute some lines of code for several times

• The initializer is only executed once; at the beginning.

• The condition is checked every time before the whole block is executed.

• After block execution, the counter is increased.

// do something once

for( i = 0; i < 10; i++ ) {

// do something for 10 times

}
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Loops

• The for statement allows to execute some lines of code for several times

• The initializer is only executed once; at the beginning.

• The condition is checked every time before the whole block is jumped over.

• After block execution, the counter is increased.

// do something once

for( i = 0; i < 10; i++ ) {

// do something for 10 times

}

2. check condition
If false: exit the loop
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Loops

• The for statement allows to execute some lines of code for several times

• The initializer is only executed once; at the beginning.

• The condition is checked every time

• After block execution, the counter is increased.

// do something once

for( i = 0; i < 10; i += 1 ){

// do something at each 

// iteration of the loop

}

// do another thing once

1. The counter is initialized
2. check condition: 

• if true: execution code in the 
loop 

• if false: exit the loop 
3. increase counter

Step 2 and 3 are repeated until the 
condition is false and the loop exits
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Troubleshooting: Tracing

• Tracing means printing something out after every line of code to ensure the path of execution is gone 
right.

// print numbers

for ( i = start; i > end; i++ ) {

if (i > 5) {

print(i);

}

}

print("start: " + start);

print("end: " + end);

// print numbers

for ( i = start; i > end; i++ ) {

if (i > 5) {

print(i);

}

}

print("start: " + start);

print("end: " + end);

// print numbers

for ( i = start; i > end; i += 1 ) {

print("is this ever printed?");

if (i > 5) {

print(i);

}

}

?

troubleshooting_tracing.ijm
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Troubleshooting: Tracing

• Tracing means printing something out after every line of code to ensure the path of execution is gone 
right.

// print numbers

for ( i = start; i > end; i++ ) {

if (i > 5) {

print(i);

}

}

print("start: " + start);

print("end: " + end);

// print numbers

for ( i = start; i > end; i++ ) {

if (i > 5) {

print(i);

}

}

print("start: " + start);

print("end: " + end);

// print numbers

for ( i = start; i < end; i += 1 ) {

print("is this ever printed?");

if (i > 5) {

print(i);

}

}

• Don’t forget to remove the “traces” after you found the bug!

troubleshooting_tracing.ijm
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Working with image files in a folder

• The files in a folder are represented as an array[]

// initialise program

foldername = "/Users/rhaase/temp/";

// get all files in the folder as array

list = getFileList( foldername );

// print out the array; item by item

for (i = 0; i < lengthOf(list); i += 1 ) {

filename = list[i];

print( filename );

}

Built-in command Description Parameters

filenameList = getFileList(foldername) return a list of file names location name of the folder

process_folder.ijm
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Hint

• Use auto-completion!
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Learning by doing!
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ImageJ macro programming: 
Arrays, Plots and Tables

Robert Haase

October 2021
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Recap: Variables

• Variables are memory blocks where you can store stuff

5

“Drosophila”

“Drosophila5”

measurement

name

combination

Computer memory
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Arrays

• Arrays are variables, where you can store multiple stuff

0

array

Computer memory

arrays_access.ijm

0 0 0 0

1

array

0 0 0 0

1

array

0 5 0 0

1

array

0 5 0
Rab
bit
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Arrays: pitfalls

• Variable assignment: by value

• Array assignment: by reference

arrays_variable_comparion.ijm
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Arrays

• Arrays can be initialized with values (more than 1)

• Find out what else you can do with Arrays by starting typing:

v = newArray(3, -4, 0);

animals = newArray("dog", "cat", "mouse");

• Arrays can be concatenated: mixed = Array.concat(v, animals);



@haesleinhuepf 118Virtually at CCI Gothenburg, October 2021

Arrays and plots

• Simple plots can be drawn using arrays
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Learning by doing!
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Break: 15 min

September 2021
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Working with tables
Robert Haase

With materials from 

Benoit Lombardot, Scientific Computing Facility, MPI CBG

October 2021



@haesleinhuepf 123Virtually at CCI Gothenburg, October 2021

Results tables

• ImageJ/FIJIs tool for collecting data/measurements 

• programmable as well

• Create tables with measurements

• Read cells

• Write cells

• Add columns

• Save as CSV or XLS file
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Creating results tables

• Two ways for creating result tables

run(”Analyse Particles...", "display");

roiManager("Measure");
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Creating results tables

• Configure what to measure...

• Menu Analyze > Set measurements...

run("Set Measurements...", 

"area mean standard min centroid center 

perimeter fit shape median redirect=None 

decimal=4");

... by entering the first word 
behind the checkbox.
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Reading from tables

• Reading elements in tables

area = getResult("Area", 0);

print(area);

r = nResults() – 1; // last row

area = getResult("Area", r);

print(area);

Built-in command

value = getResult (“column title”, rowNumber);

rowCount = nResults();
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Writing in tables

• Manipulating (and adding) elements in a table

Built-in command

setResult (“column title”, rowNumber, newValue);

r = 0; // first row

setResult("Area", r, -5);

Handle with care!



@haesleinhuepf 128Virtually at CCI Gothenburg, October 2021

Logging, working with text files

• There is an alternative to write simple tables and text files to disc

save_csv_file.ijm

That might be useful in 
the exercise tomorrow.
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Try it out



@haesleinhuepf 130

ImageJ macro programming: 
ROI and Overlays

Robert Haase

With material from 

Benoit Lombardot, Scientific Computing Facility, MPI CBG 

Virtually at CCI Gothenburg, October 2021
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Selection versus masks

• Selections and masks are exchangeable.
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Selections versus masks

• Some operations for selections you know already from masks.

ErosionDilation

Enlarge Shrink

C
reate 

Se
lectio

n

C
reate 

Se
lectio

n

C
reate 

Se
lectio

n

Slide adapted from Haase, Lombardot, Scientific Computing Facility, MPI CBG, licensed CC BY-NC 4.0
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ROI Manager

• Every button in the ROI Manager can be called from a macro. 

Built-in command

roiManager(“add”);

roiManager(“delete”);

roiManager(“rename”, name);

roiManager(“measure”);

roiManager(“deselect”);

roiManager(“open”, filename);

roiManager(“save”, filename);
roiManager(“save selected”, filename);

roiManager(“select”, index);
roiManager(“select”, newArray(index1, index2, ...));

roiManager("show all");
roiManager("show all with labels”);
roiManager("show none”);

roiManager(“and”);

roiManager(“combine”);

roiManager(“reset”);

roiManager(“split”);

roiManager("count");

• Hint: Use the macro recorder!
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Regions of interest

• ROIs can be used for visualization of (intermediate) results
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Overlay

• You can collect ROIs in the “Overlay”

overlays.ijm
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Overlay

• Overlays can be flattened – for visualization purposes

// burn in the overlay 

// in the image

run("Flatten");

This is no longer 
an 8-bit image!
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ROI Manager, Results tables and Overlays

• Custom visualization with a for loop

visualise_area_in_colors.ijm

Image data source: Anne Esslinger, Alberti lab, MPI CBG
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Overlay

• Explore what you can do with overlays by starting to type…
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Custom Macro Functions
Robert Haase

October 2021
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Functions

• For reusing code and for organizing code: Use functions!

function 
definition

return 
value

function 
call

function 
call

user 
documentation

name parameters
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Try it out
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Exercises

Virtually at CCI Gothenburg, September 2020
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Exercise: loops

// initialisation

loop_count = 10;

// print 10 numbers

for( i = 0; i < loop_count; i++ ){

print(i);

}

• Use this example code to program a for loop which 
counts backwards from a given number to 0.

exercise_for_loop.ijm
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Exercise: Counting nuclei

• Visit the Broad Bioimage Benchmark Collection Website and download BBBC007
https://bbbc.broadinstitute.org/BBBC007
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Exercise: Counting nuclei

• Write a for-loop that goes through the A9 folder of BBBC007 and prints out all filenames ending with 
“d.tif”
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Exercise: Counting nuclei

• Extend your script so that it counts nuclei in these 
images using one method of your choice.

• Hint: The number of objects in a label-image equals 
the maximum intensity of that image.
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Exercise: Counting nuclei

• Extend your script so that it applies the algorithms from 
yesterday to your image

• Thresholding + Watershed

• CLIJ

• StarDist

• Hint: If you make the algorithms save ROIs to the ROI 
manager, you can count the elements in the ROI manager to 
know how many objects there are in the image.
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Exercise: Counting nuclei

• Extend your script so that it outputs the results to a table.
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ImageJ, Fiji & friends: community

• Visit http://forum.image.sc !
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Summary

Today, you learned                        Reminder: Clean up recorded code! Write comments!

• Conditions (if)

• Loops (for)

• Results tables

• Arrays

• Plots

• Tables

• Processing folders // do something once

for( i = 0; i < 10; i += 1 ){

// do something at each 

// iteration of the loop

}

// do another thing


